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1 Introduction 

The Rapidox 1100-OPT-MAX O2 analyser is supplied with Windows software that allows the user to remotely 
reconfigure the analyser and perform live time data logging.  The unit can be remotely calibrated and an on-
screen LCD emulator allows the PC screen to become a remote display. 

1.1 Models covered by this manual 

This manual describes the following product variants in the Rapidox 1100 family.  

Note:  although the software for these analysers is very similar not all features are available for all 
models. 

• Rapidox 1100-OPT-MAX 

1.2 Software Features 

The software has been tested successfully on most language machines including Chinese, Korean & Japanese 
and all current versions of Windows operating system. 

Note: The software is ‘regionally aware’ and will therefore accept and display data using the 
decimal separator that is set in the PC’s Regional Settings in the Control Panel.  For example, in the 
UK or US, you might enter the value 2.5 - in continental Europe this would normally be entered as 
2,5 assuming the PC’s Regional Settings have been set up to use ‘,’ as the decimal separator. 

1.3 Software Installation 

The software is installed automatically from the USB memory stick supplied.  If auto-installation does not start 
then you can click the Windows START button and select RUN.  Type X:\setup.exe where X is the drive letter of 
your USB drive.  Alternatively access the memory stick drive from Windows Explorer or the ‘My Computer’ icon 
on your desktop and double-click on the ‘Setup.exe’ programme.  Follow the on-screen instructions to install 
the programme onto the hard drive.  Once installed, you can access the programme by clicking START - 
PROGRAMS – Rapidox Software. 
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2 Getting Started 

2.1 Connecting 

To connect the Rapidox analyser to a computer you will need a suitable USB to RS232 converter cable.  These 
are readily available from computer supplies shops or can be purchased directly from Cambridge Sensotec.  
We strongly recommend that you select a cable that uses FTDI chipset technology as these tend to give the 
most reliable connections. 

 
Figure 1: USB to RS232 converter cable required to connect to the Rapidox 

Make sure that the cable is connected to a free USB port on your computer and the drivers have correctly 
installed.  Switch on the Rapidox unit before starting the software.  Once started, the software will scan 
through the available COM ports until it finds the Rapidox.  The following home screen will be displayed: 

 

 
Figure 2: Rapidox home screen.  Actual values may differ from those shown above depending on the model. 
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 The window pane header shows the software version and the connected Rapidox Serial 
number.  

 Menu Bar.  Click on a title to view the drop-down menu sub-headings. 

 Tabs menu.  Click on the tab name to view each individual screen in the main panel. 

 This displays the serial number and firmware of the analyser. 

 These quick-link buttons are used to access important functions directly from the home 
screen. 

 The status bar shows the result of the last action, or any error messages as well as the current 
data and time. 

 

The home page can be accessed at any time by clicking on the tab labelled ‘Home’ 

2.1.1 On Screen Help 

You can access the on-screen help facility at any time by clicking on the help menu on the menu bar and select 
the ‘Help’ option or press F1.  There is also a quick link button on the home screen. A full instruction manual is 
displayed in pdf format. 

2.2 Renaming the Analyser 

You can give the analyser a name which will help to identify it if you are working with multiple machines.  Click 
on the quick-link button labelled ‘Rename Analyser’: 

 

 
Figure 3: Rename the Analyser 

 
Press OK to save the new name and return to the home page where the name will display until next changed: 

 



7 
Rapidox 1100-OPT-MAX Software Instruction Manual. Revision: D11-218-1 

 
Figure 4: Homepage showing the new name of the Rapidox 
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3 On Screen LCD 

It is possible to display an LCD emulator on the PC monitor.  This reproduces the display on the Rapidox unit 
and is convenient if you are some distance away from the machine.  To activate the LCD select the UTILITIES 
menu and select the LCD on option or use the quick-link button on the home screen.   This will display a 
window showing the LCD that can be positioned independently anywhere on the desktop. 

 

 
Figure 5: Open the LCD emulator window using the Utilities menu 

 

 
Figure 6: On-screen LCD emulator in default colouring 

 
The default image is black with white text but this can be changed to suite your own preference.  Right click 
over the screen to see options to change the colour of the background and the colour of the text.  Alternatively 
choose one of the pre-set colours e.g. ‘retro LCD’ 

 
Figure 7: Right click on the LCD panel to choose different colour options 
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Figure 8: Example showing ‘Retro LCD’ selected. 

 
The LCD window can be resized right up to full screen by stretching the bottom RH corner.  Click and hold your 
mouse in the circled area to resize.  The size and position of the screen are remembered for next time. 
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4 Analyser Configuration 

The on-screen edit boxes contain variables that can be reprogrammed into the Rapidox in the same manner as 
using the front panel keypad.  For a full description please refer to the relevant section in this manual. 

The user can choose whether to use ppm or percent notation to edit the text boxes, where appropriate, by 
selecting the ‘Units’ menu and clicking on ‘Percent’ or ‘ppm’.  To access a field, either click inside it or use the 
TAB key to scroll through them. 

The analyser configuration tabs allow the user to view and set new parameters that can be loaded into the 
Rapidox.  For example the pump speed can be changed from here.  The configuration is split into two tabs 
labelled as ‘Config 1’ and ‘Config 2’ on the tabs menu.  Values and settings can be modified and then written 
across to the Rapidox when ready. Once written to the Rapidox, the new variables remain permanent until 
overwritten. 

 
Figure 9: Config 1 tab with key elements highlighted. Exact parameters on display vary between models 

 
 Click Read to update the columns below with the present settings from the Rapidox analyser. 

 Use the Copy button to tranfer all the settings across into the edit box column. 

 Make any changes to the configuration in the right-hand column.  Changes values remain red 
in colour until they are copied over to the Rapidox. 

 When ready press Write to send all the changes back to the analyser or select ‘Write 
Configuration to the Analyser’ from the File menu. 
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 Default Configuration: If at any time you wish to restore the machine to its factory default 
settings select ‘Default Configuration’ from the File menu to load these values.  The software 
will search for a unique ‘.rxc’ file that is loaded onto the PC during the software installation.  
The filename is 2100***.rxc where *** is the last three digits of the serial number located on 
the rear of the machine.  This file is also located on the USB memory stick that came with the 
machine.  Normally this file is located in ‘My Documents’ directory but if the software cannot 
locate it then it will ask you for the serial number to help it search. 

 Load Configuration: A saved data set can be reloaded at any time by selecting ‘Load 
Configuration File’ from the File menu and then selecting the folder where the configuration 
files have been stored.  With the correct rxc file loaded into the ‘Read’ columns, simply click 
>> (copy) to transfer the defaults into the edit boxes and then click the ‘Write’ button to load 
it back into the Rapidox. 
 
Note: if a password option has been enabled you will be asked for the correct password to 
proceed with this operation. 

 To save a configuration (e.g., if several people share the same instrument) click the long copy 
(‘>>’) button (between the ‘Read’ and ‘Write’ columns) in order to transfer the data into the 
edit boxes, select ‘Save Configuration as’ from the ‘File’ menu and choose a filename.  This 
data set can be subsequently reloaded at any time by selecting ‘Load Configuration File’ from 
the File menu and then selecting the folder where the configuration files have been stored. 

 

4.1 Config 1 Tab 

All options on Config 1 page are selected from a list of pre-set choices given to you.  The options can vary 
slightly depending on the model type and may appear greyed out if not applicable. 

 
Figure 10: Configuration 1 page.  Actual values used may differ from those shown above depending on the 

model. 
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1) O2 Units & Format:  Use the drop-down menu to select AUTO, %, PPM, EXPONENTIAL PPM,.  The 

default setting is AUTO. 

2) Pressure Units: Use to select MBAR, KPa, TORR, BAR or PSI as the unit for pressure measurement.  
The default setting is MBAR. 

3) Pressure Correction Mode: Use to select NONE or AUTOMATIC.  The default setting is AUTO. 

4) Switch Point: Use to select the oxygen value at which point the high range (%) sensor switches 
over to the low range (ppm) sensor.  Options are 500ppm, 1000ppm, 1500ppm & 2000ppm with 
the default set to 1000ppm. 

5) Temperature Units: Use to select between none °C and °F 

6) Pump Speed:  Use to select a pump flow value from 10-100% or OFF.  The default is 70%. 

7) Display Refresh interval:  Use to select a refresh rate for the LCD (min 0.1, max 1.5 sec).  The 
default is 0.3 seconds. 

8) LCD Third Line Option: Use this to select what is displayed on the third line of the display.  
Choose from TEMPERATURE, BALANCE or NONE.  Note that when BALANCE is selected a new 
drop down option appears allowing you to select the gas name for the balance gas. 

9) Balance Gas: Use this to select the balance gas label from N2, Ar, CO2, He, H2 or BALANCE 

10) LCD Fourth Line Option:  Use this to select what is displayed on the fourth line of the display.  
Choose from DATE & TIME, TEMPERATURE or NONE. 

11) Password Protection:  The password is factory disabled and set to 0000.  Use the drop-down 
menu to enable or disable the password feature and the password box **** can be used to enter 
a new password if required.   

Note:  you will be prompted to enter the original password to make any changes to the password 
or its status: 

 
 

 
Figure 11: Password prompt menu screens. 
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4.2 Config 2 Tab 

All options on Config 2 are values that the user can change by entering new ones. 

   
Figure 12: Configuration 2 page.  Actual values used may differ from those shown above depending on the 

model.  Note that pressure is absolute on this analyser model. 

 

1) Output 1 Parameter:  Use the drop down to select between OXYGEN, PRESSURE or BALANCE. 
The balance gas option will allow the current balance gas calculation on line three of the display 
to be assigned as an analogue output. 

2) O2 Analogue Output (0V/4mA & 10V/20mA):  Use these two boxes to set the High and Low 
oxygen values for the analogue outputs labelled on the rear panel of the instrument.  For 
example shown above if you want 4mA to represent 0.5ppm and 20mA to represent 210,000ppm  
then enter these two values into the appropriate boxes.  The value can be entered either in % or 
ppm depending on the units selected.  The default is %.  The default values are 25% for the high 
setting and 0.001% for the low setting. 

3) Output 2 Parameter:  Use this drop down box to select between OXYGEN, PRESSURE or 
BALANCE.  The balance gas option will allow the current balance gas calculation on line three of 
the display to be assigned as an analogue output 

4) Analogue Output (0V/4mA & 10V/20mA):  Use these two boxes to set the High and Low auxiliary 
(oxygen pressure or balance gas) values for the analogue outputs (6) on the rear panel of the 
instrument.  For example shown above if you want 0V/4mA to represent 900mbara and 
10V/20mA to represent 1100mbara then enter these two values into the appropriate boxes.  The 
pressure units are displayed in the same units as selected on the Config 1 page. 
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4.3 Cal Values Tab 

The values on this page are shown for information purposes and can not be adjusted by the user.  To calibrate 
the instrument please use the menu system on the analyser following the instructions in the main user 
manual. 

 

 
Figure 13: Calibration Values are displayed here 
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4.4 Alarms Tabs 

There are two alarm tabs, one for each alarm.  They are both identical in nature and described together in this 
section. 

 
Figure 10: Alarm configuration screen.  Actual values used may differ from those shown above depending on 

the model. 

 

1) Alarm Source: Use the drop-down box to assign a detector to the alarm.  If you want the alarm to 
be based on O2 readings, select oxygen from the drop-down list.  The choices are: OXYGEN 
BALANCE GAS or PRESSURE.  The default setting is OXYGEN. 

2) Alarm Delay: If required use the drop -down menu to select a delay period before the alarm will 
trigger.  Having a short delay prevents noise spikes causing a false alarm.  The default is OFF. 

3) Alarm Outputs:  This option enables or disables the alarms on the rear panel (labelled Alarm High 
+/- and Alarm Low +/-).  Make sure these are enabled if you wish to use the signals from the 
alarm circuit. The default setting is OFF. 

4) Audible Alarm:  This option enables or disables the audible buzzer fitted to the Rapidox 
internally.  When an alarm condition occurs the buzzer will emit a continuous noise to alert the 
operator.  The default setting is OFF. 

5) Visible Alarm:  This option enables or disables the visual warning on the front display.  When 
enabled and an alarm condition occurs the message ‘ALARM 1’ or ‘ALARM 2’ will flash on the 
display to show which value is in alarm.  The default setting is OFF. 

6) Rising or falling Alarm: This option allows the alarm to be set as a rising or falling type.  If the 
alarm is rising then the reading must rise above the set-point for the alarm to be activated.  If the 
alarm is falling then the reading must fall below the set-point for the alarm to activate.  The 
default setting is FALLING. 
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7) Contacts Normally Open or Normally Closed:  This option allows the user to programme how the 
relay contacts are set on the rear panel.  Normally Open means that the contacts are open circuit 
when an alarm is not activated and Normally Closed means that the contacts are closed when the 
alarm is not activated.  The default setting is NORMALLY OPEN. 

8) Output Latching: This option sets the alarm to latching or non-latching mode.  See the main 
instruction manual for details of how this feature works. 

9) Alarm Setpoints: Use this box to programme the set-point value at which you want the alarm to 
activate.  The units are in %, ppm or mbar depending on which sensor you have assigned to the 
alarm. 

Once you have finished editing all the parameters, select ‘Write Configuration to Analyser’ from the file menu  
or click on the ‘Write’ button on any of the tabs and the new data set will be written to the Rapidox.  The 
Rapidox is reprogrammed using the new configuration.  The software then reads the new settings back from 
the Rapidox and displays them in the boxes on the left-hand side confirming that the configuration was 
successful. 

4.5 Cancelling a Latching Alarm 

If a latching alarm activates then the alarm will remain on the Rapidox until it is cancelled by pressing the 
“ESC” button on the front panel.  The latching alarm can also be cancelled remotely from the software by right 
clicking on the display emulator window and selecting “Clear Alarms”: 

 
Figure 14: Right Click on the display panel to clear a latching alarm 

 
Note:  If the alarm state is still active then the latching alarm will clear for a few seconds before re-
enabling itself.  The only way to permanently clear a latching alarm is to make sure the Rapidox 
reading is out of an alarm condition first.  This is a standard safety feature to prevent users clearing 
an alarm before conditions recover. 
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5 Data Logging 

The Rapidox software includes a full data logging facility.  Data can be saved to a file automatically at regular 
intervals and the format is compatible with modern spreadsheet programmes such as MS-Excel.  A live-time 
graphing facility is also included which has many powerful features.   

Note: the data logging facility will only function if the analyser is in NORMAL run mode. 

5.1 Data Acquisition Tab 

Click on the tab labelled ‘Data Acquisition’ to display the following page. The options can vary slightly 
depending on the model type and may not be visible if not applicable. 
 

  
Figure 17: Data Logging page 

 

 During logging, data from the analyser is shown in the central area of this page.  The data is 
displayed in the following columns: time (in seconds), sensor signal (in mV), O2 value in the 
units of choice, pressure in the units of choice, time (in regional format), the date (in regional 
format), and alarm status (displays either ALARM1, ALARM2 or ALARM1&2 if activated). 

 Select how frequently you want to take readings and, if time limit is enabled, how long to log 
for. 

 Check the ‘Time Limit’ box if you want to run the logging for a set period. Check ‘Save to file’ if 
you want to save the log, Check ‘Auto Date Stamped Files’ if you are intending to log for a 
long time period >12 hours. 

 Displays information about how long the logging has been running for and low long is 
remaining. 
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 Shows the total number of data points collected so far. 

 Use these buttons to Run, Pause or Stop the logging. 

 Click here to open the live plotting feature. 

 

5.2 Running the Data Logger 

If you wish to save the data into a file for later use, check the ‘Save to File’ box before selecting ‘Run’ from the 
Data Logger menu.  You will be prompted for a file name and location before data logging commences.  The 
file and path information will appear in the box at the top of the page labelled ‘Data File Name’.  If you forget 
to select file saving before starting a run, you will nevertheless be prompted at the end as to whether you wish 
to save the run data. 

The green progress bar displays the state of completion of the run, and the blue box to the right of it the same 
information as a percentage.  You can stop the run at any time by selecting ‘Stop’ from the Data Logger menu.  
The Status bar at the bottom of the page gives information about the data logging operation. 

Once data logging is complete you may open the text format data file using any compatible spreadsheet 
programme such as MS Excel, and use the data to generate plots and reports. 

You can open the NOTES window at any time by selecting NOTES from the ‘Data Logger’ drop down menu.  A 
small text box appears in which you can type a text message.  This NOTE is then saved as a header in the data 
file set and can be viewed along with the data. 

5.2.1 Data Logging in the Background 

It is possible to begin data logging and then minimise the windows to continue working with another 
application.  To minimise the graph simply click on the minimise button on the blue title bar at the top of the 
window.  You can then use the ALT + TAB keys to take you to other programmes already running.  To return to 
the graph simply maximise from the start menu bar or press ALT + TAB again.  If the graph does not redraw 
immediately select ‘Zoom Full’ from the View menu to redraw. 

5.2.2 Changing the Data Logging Parameters Mid-run 

Once the data logging has begun you may change the sample interval time by pausing the data logger and then 
entering a new value for the time interval.  The data logger can then be resumed with the new values in place.   

Note:  you cannot change units (e.g., seconds to hours) once logging has started.  If you originally 
selected seconds then you may change the current value to a new value between 1 and 3600 
seconds, if you originally selected minutes then you may change between 0.02 and 360 and if you 
selected hours you may change between 0.01 and 6 hours.  

Note:  it is not possible to modify he original total length of time that the data logging will run for 
once a run has commenced. 

5.2.3 Auto Date Stamped Files 

If you are planning to run the data logger for extended periods of time then you should consider checking the 
‘Auto date stamped file’ option.  This feature will save the data at midnight for the previous twenty four hours 
and so on until the data-logging is complete OR the user interrupts.  The data file is stored with a date suffix in 
brackets in yy-mm-dd format. 

This feature ensures that data is saved periodically in sensible sized files.  This will prevent the computer from 
crashing and will also ensure that the data is small enough to fit into an Excel spreadsheet 

As an example, the user wishes to run the data-logger for seven days recording every minute starting at 
lunchtime on 12th November 2025.  They start the data logger with the auto-date stamp function enabled.  
When prompted they give the filename as test1.  In this situation the data logger will run from lunchtime to 
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midnight and then save the first file as test1 (2025-11-12).  The data logger then clears and continues for 
another twenty four hours until midnight the following day.  The data is then stored as test1 (2025-11-13).  
This will continue for seven days when the data-logger will finish. 

After this the user will have a sequence of files: 

test1 (2025-11-12).txt 
test1 (2025-11-13).txt 
test1 (2025-11-14).txt 

And so on.  Combined together they represent all the data over the last seven days. 

Note: the Rapidox uses the computer clock and date to perform this action, so make sure that they 
are correct before starting a run.  To view the data in its entirety the user would need to load each 
file in turn back into Excel to combine. 

5.3 Live Time Graphing Screen 

The Rapidox data-logging package includes a live-time graphing facility that allows you to monitor the progress 
of your data in a graphical format (see Figure 15).  To access the graph click the button labelled ‘Show Plot’.  
The graph will appear in a new window, and can be accessed at any time without disturbing a run that is 
already in progress.  To close the window and return to the main data-logging page select ‘Close Plot’ from the 
File menu or click on the close window button.  Click on the ‘Properties’ button to change the style and colours 
of the graph. 

 
Figure 15:  Live-time graphing screen showing O2 Y1-scale (red) and a linear pressure Y2-scale blue) on the 

same graph together. 
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5.4 Plot Properties 

The properties of the plot can be modified to suit your needs by clicking on the button labelled ‘Properties’ or 
inside the legend or along any of the axes.  The Plot Properties box will be displayed 

 
Figure 16: Chart Properties Window 

 
 Select the the type of graph you want to view using this drop-down menu: 

a) Single Chart with Primary & Secondary Plotted on Y1 and Y2.  This default is a single chart 
with two gases (O2 and Pressure) plotted on the Y1 and Y2 axes. 
b) Single Chart with Primary & Secondary plotted on Y1 as %.  This chart option is more 
suitable for Rapidox analysers fitted with multiple sensors that all have different scales.  The 
chart plots each sensor value in terms of percentage of the scale 
c) Multiple Separate Charts for each Primary & Secondary.  This will draw a separate graph for 
each gas or pressure or temperature depending on the excat configuration of the analyser. 

 The primary and secondary gases / pressure / temperature can be selected for plotting from 
here.  The primary gas is always plotted on the Y1 axis and the secondary is on the Y2 axis. 

 The way the data are plotted can be changed by selecting the unit of choice and clicking ‘Edit’ 
to open the Trace Properties box shown in Figure 17 below 

 Select the time span of the X axis here – choose from displaying All the data or a specific Time 
Window or a Fixed Time Duration. 

 
Once all your changes have been made click on Apply to view the result and OK to finish and close the 
Window. 
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5.4.1 Trace Properties 

The default colours used on the graph are set to blue for O2 and red for pressure.  To change the colours, units 
as well as the scale and limits use the Trace properties menu box. 

 
Figure 17: The Trace Properties menu allows the user to format axes and colours of individual plots. 

5.4.2 Plot Colours 

The default colours used on the graph are set to blue for O2 and red for pressure.  To change the colours use 
the Trace Properties Window shown above and click ‘Change’.  A colour palette window will appear (see Figure 
18) and a new colour can either be chosen from a colour box, or for more variety, by clicking the ‘Define 
Custom Colours >>’ button.  Click on ‘OK’ to select the new colour or ‘Cancel’ to return to the graph without 
change. 

 
Figure 18: Plot colour palette menu accessed through the Chart Properties Window. 

5.4.3 Zooming the Graph 

The graph window can be stretched to a new size on the screen by placing the mouse in the graph pane and 
dragging an area where you want to zoom to before releasing the mouse button. 
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Figure 19: Zooming into an area of a graph by dragging the mouse 

 
 Use the sliders to scroll the chart left to right and up and down once in zoom mode. 

 Click on the Close buttons to return the graph to the normal size.  There is one close button 
for each axis. 

5.4.4 Printing Graphs 

You can print the graph at any time by selecting ‘Print Plot’ from the File menu.  This will bring up the printer 
dialogue box for your specific printer where you can choose various printing options.  Make sure that the 
printer page is set to landscape to obtain a full size print out. 
  



23 
Rapidox 1100-OPT-MAX Software Instruction Manual. Revision: D11-218-1 

5.5 Working with Spreadsheets 

The data-logger saves data files in a standard comma separated ASCII text format which can be readily 
imported into spreadsheet programmes such as MS Excel, in order to produce plots and reports as desired.  
For specific information on how to import text files into your spreadsheet programme please refer to the help 
guide supplied with the programme. 

Data is saved in comma separated value format, with a ‘.txt’ file extension as the initial programme default.  
However, when entering the file name, you can instead select a ‘.csv’ extension: the programme will register 
the last used file extension as the new default.  The ‘.csv’ extension is recognised by MS Excel, so that opening 
the file will automatically run MS Excel, and this may be of benefit if your regional decimal separator is period 
‘.’ rather than comma ‘,’.  However, if your decimal separator is comma, you should continue to use the ‘.txt’ 
extension and open the file explicitly from within your spreadsheet programme, defining the field delimiter as 
‘comma’ where appropriate. 

5.6 Disaster Recovery 

To prevent catastrophic loss of important data during a computer crash or power failure, the data is 
automatically saved point by point in a temporary file called ‘Rapidox temporary data file 2100xxx.txt’, where 
2100xxx is the serial number of your Rapidox.  This file is located in the same directory as the main Rapidox 
programme itself and can be renamed or copied to recover data that would otherwise be lost.   

Note: this file is overwritten each time ‘Run’ is selected from the ‘Data Logger’ menu so make sure 
all data is recovered successfully before starting another run. 

Note: during a run using the ‘auto date stamped’ feature, the temporary data file is wiped clean as 
soon as the previous data set has been saved successfully.  In the case of a crash the temporary 
data file should be used to recover the last day’s worth of data that was not saved to the hard disc. 

5.7 Software Utilities 

The utilities menu is located on the main file menu as shown in Figure 5 above.  Here the LCD window can be 
opened and closed as well as setting the date and time. 

5.7.1 Setting Analyser Date and Time 

The current date and time of your PC are displayed on the configuration screen and can be loaded into the 
Rapidox by selecting the Utilities menu and clicking the ‘Set date and time’ option.  This information is used in 
the RS232 data string for data logging purposes.  Make sure that your PC clock is set correctly before using this 
function, as you cannot edit the date and time shown by the Rapidox software.  The date and time formats 
displayed are those set in the PC’s Regional Settings. 

5.7.2 Image Grabber 

This is a simple function to allow the user to copy the software screens into the Windows clipboard.  This is 
useful for diagnosing problems; allowing a quick and simple way of sending the Sensotec technicians actual 
screen shots of the software.  To recover the images simply press CTL+V to paste. 
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6 Remote Calibration 

It is possible to calibrate the analyser using the software which is often a more convenient way and removes 
the need to constantly access the menu using the front panel keys. 

6.1 About calibration 

The two optical sensors are extremely stable and virtually drift free meaning that the factory calibration should 
be fine for most users.  However periodic calibration is still highly recommended every twelve months to 
achieve full accuracy.  

You can re-calibrate the Rapidox 1100-OPT-MAX analyser using any three calibration gases (LOW, MIDDLE & 
HIGH) as long as HIGH > MIDDLE > LOW and the MIDDLE gas falls within the sensor switching point range (500 
- 2500ppm O2). The cal gas values are factory set as LOW = 10ppm, MIDDLE = 1000ppm & HIGH = 209,500ppm, 
and we recommend that you don’t change these unless you have a good reason.  During each calibration, the 
two sensors are exposed to the correct calibration gas from a cylinder until the display reading is stable. 

The OPT% sensor is calibrated using the HIGH and MIDDLE cal points and the OPTppm sensor is calibrated 
using the MIDDLE and LOW cal points.  This means that the two sensors are locked together by the MIDDLE cal 
point and both sensors are calibrated at the same time in the same gas at the switchover point which 
guarantees a smooth transition from high to low during use. 

You can calibrate the analyser HIGH using any calibration gas including air (20.95%) as long as it is >0.1% 
oxygen. For the MIDDLE calibration the oxygen value is restricted to between 500ppm (0.05%) and 2,000ppm 
(0.25%) since both sensors must be calibrated at the same time, in gas that is compatible with their scale.  The 
LOW calibration can be completed on any gas <1000ppm including 6.0 N2 for a zero point (0.00%). 

Typically, the factory settings are: 

• HIGH  =  209,500ppm (20.95%) O2  (fresh air can be used 20.954%) 
• MIDDLE  =  1000ppm (0.1%) O2 
• LOW  =  10ppm (0.001%) O2  (pure N2 6.0 can be used for a zero point) 

Note: the calibration points are independent of each other so you can calibrate the analyser in any 
order you desire. However, you must ensure that HIGH  > MIDDLE > LOW. 

6.1.1 Before you start 

1. Decide which gases you are going to use for calibration. If you constantly work at a specific range of 
compositions, it would be wise to obtain small cylinders of calibration gas with analysis certificates. 
Cambridge Sensotec can supply these.  

2. you want to work in different units, select this using the Units menu on the software main window 

Note:  You should always perform a full calibration to achieve good accuracy.  

Note:  Under normal operation an annual calibration will prove sufficient. All Rapidox analysers can 
be returned to Cambridge Sensotec for a range of service and calibration options. Please contact us 
for further information. 
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6.2 Software Calibration Menu 

 

The calibration menu is accessed from the Home page by clicking on the button labelled ‘Calibrate’ 

 
Figure 20: Accessing the Calibration Software 
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Figure 21: The current calibration is displayed visually on a chart showing the LOW and HIGH points for both 

the ppm and % scale sensor. 

 

 The current calibration values are shown here in colour coded format.  Simply click ‘Calibrate’ 
on the point of interest to continue 

 

6.3 Example Calibration 

As an example using air is shown.  Clicking on “High % Cal Gas” calibrate button takes you to the actual 
calibration screen for this gas: 
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Figure 22: Example showing the ‘High| Cal point’ calibration screen. 

 
 To start the calibration process click ‘Run’ to start data graphing. 

 The notes will prompt you what to do during the process of calibrating. 

 The value of the calibration gas you are using should be entered here either by typing or using 
the up and down arrows to make small changes. In this case the cal gas being used is fresh air 
(20.95%). 
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Figure 23: Calibrating the High Gas with fresh air. 

 
 Use Run, Pause or Stop to control the graphing 

 The notes guide you as to what to do next – wait until the gas reading has levelled out 
completely before pressing ‘Calibrate’ 

 Click on Chart Properties to adjust the chart settings.  See Figure 24 below for details 

 
Figure 24: Calibration Graph Properties window.  Here you can customise the view of the 

graph.  The colour for O2 is locked and linked to the colours used in Figure 21. 

 

 The legend shows the colours for O2 and pressure.  Note that the O2 colour is coded and fixed 
to match the previous windows.  The pressure colour can be changed if required 

 The current live readings for O2 sensor and pressure are displayed here.  The pressure reading 
needs to be atmospheric +/-25mbar for a successful calibration. 

 A live mV reading is displayed to show the quality of the sensor.  For information only. 
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 Press Calibrate to save the new value and return to the previous screen.  A summary will be 
shown as in Figure 25 below: 

 

 
Figure 25: Confirmation of the new calibration settings are displayed 

 

With the calibration completed for the first gas the user is returned to the window shown in Figure 21.  The 
completed calibration points are indicated by a tick: 

 
Figure 26: Calibration window indicating that the High gas calibration has been completed 

 
If you want to reset a calibration simply right click over the green tick box to select undo. 
 

 
Figure 27: Undo a calibration 
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Repeat the above process until you have completed all the calibration points, or some of them if you are only 
doing a partial calibration.   

6.4 Programming the Calibration 

The updated calibration is only sent to the Rapidox unit when you are finished and ready to update everything 
together.  When ready click on the button labelled ‘Write’ to reveal: 

 
Figure 28: Message warning that the calibration is about to be sent to the Rapidox 

 

 
Figure 29: Confirmation that the Calibration was loaded into the Rapidox successfully 

 
If you want to modify the number of calibration points press the ‘Back’ button.  You will see a prompt 
confirming this is what you want to do. This will reset all calibrations that you have completed. 

 
Figure 30: Prompt asking you if you really want to go Back without copying the calibration to the analyser 

 
Alternatively pressing ‘Home’ will result in the following prompt being displayed: 

 
Figure 31: Prompt reminding you that you are trying to cancel without saving the calibration to the Rapidox. 
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7 Diagnostics 

 

The Rapidox software includes a diagnostics page that is accessed from the tab labelled ‘Diagnostics’.  This 
screen will display various values and settings that are operating inside your machine.  There is no editing 
possible on this page – it is purely for information and to enable technical support help you should you 
experience difficulties with your machine.  You may be asked to record values from this page if trouble 
shooting is required. 

 

 
Figure 32: Rapidox Diagnostics Page.  The exact layout of this screen varies from model to model. 

 
 Analogue:  the live analogue values displayed in this pane are voltage measurements coming 

directly from the computer chip inside the analyser.  They are for information purposes only 
but are a useful diagnostics tool for Sensotec staff, as unusual values can indicate a particular 
fault.  To help Sensotec diagnose a fault please capture this window as shown above using the 
screen capture function described in section 5.7.2 above and e-mail it to 
support@cambridge-sensotec.co.uk 

 Digital: the digital signals coming directly from the computer chip inside the analyser can be 
monitored here.  To test the keypad is working correctly try pushing the buttons and watching 
the panel.  A correctly functioning key will turn the box red on the screen and the digital value 
for that particular key will show in the data box 

 Temperature Sensor: If the analyser has an external thermocouple correctly fitted (2100 and 
3100 series only) then this will display a signal in the ‘Temperature Sensor’ box 

 Sensor State:  these boxes should all indicate ‘OK’ on a healthy analyser.   

Note: this family of analysers do not have other sensors fitted so all references to 
these on this screen are not relevant.  The possible messages are ‘OK’ ‘High’ ‘Low’ 

file://sensotec-srv02/Company%20Shared%20Folders/Manufacturing/Instruction%20Manual/Sensotec/R1100%20Range/R1100-Z/R1100-ZF-FACELIFT/Current%20Source%20Files/support@cambridge-sensotec.co.uk
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or ‘Fault’.  The High and Low messages indicate that the sensor is out of normal 
range.  The fault message will only display if the sensor is disconnected or has 
failed in some way 

 Weighted Output Data: These values are being sent to the rear panel for the analogue 
outputs.  Data 0 is an indication of the ambient pressure in mbar and Data 1-4 represent the 
values for O2 and pressure being sent to the analogue output terminals for V and mA 

 Log Diagnostic Data:  If you check this box then the software will automatically start to save a 
diagnostic file in the ‘My Documents’ directory called ‘Rapidox diagnostics data XXXX.txt 
(where XXXX is the serial number of your machine).  Selecting ‘Enable Fast Log’ will log the 
data at a much shorter interval to help with certain issues.   

Note:  Diagnostic data is logged every 6 seconds, or every second if your software 
has the "Enable fast log" check box. 

Note:  Logging diagnostic data is controlled entirely by the "Log diagnostic data" 
check box - logging starts as soon as it is checked, and stops when it's unchecked. 

Note:  If you switch to a different tab diagnostic data logging will be suspended, so 
the general rule when logging diagnostic data is check the "Log diagnostic data" 
check box and then leave the software alone until you want to stop logging. 

Note:  There is no file name option, so rename the last diagnostic data file before 
logging new diagnostic data. 

Note:  Diagnostic data contains raw data from the analyser as well as either status 
messages (such as "Sensor heating") or acquisition data as you would get from the 
normal data acquisition file.  However, unlike normal data acquisition, it isn't 
suspended if the heater loses control.  Diagnostic data saving will only be 
suspended if there's a comms glitch between the PC and the Rapidox, or if you try 
to interact with the Rapidox via software.  The file is created at the start of the run, 
and as with the temporary data file, each data line is appended, so you can look at 
the file at any time.  You can therefore have a look at the file at any time (for 
example by opening it in Notepad or by copying and saving it with a .CSV extension 
for Excel) and see whether there are any anomalies. 

E-mail the file to support@cambridge-sensotec.co.uk so we can help diagnose the problem 
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